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Creating Documents with WordPad

WordPad is a free word processing program, that is part of the 
Microsoft Windows program.

A word processor is a program used to process, format, and 
store documents like letters, memos, reports, resumes and 
many more. It is also capable of producing a printed 
version, when its done.

Basic features common to all word processors:
◦ Create a document, save, retrieve files; move, copy, enhance, 

edit documents; set margins/align text, search/replace

WordPad doesn’t have a spell checker, a thesaurus, and 
advanced features that are found in the Microsoft WORD 
program, but it still is a good one for typing and editing 
basic documents.   
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WHY LEARN WORD 
PROCESSING?

It is one of the main uses 
of a computer because its 
helpful with everything !

All of the same rules 
apply whether you:

 Write a story, a book, 
or some jokes.

 Send an e-mail 
message to someone

 Send a text on the 
computer or on your 
cell phone.

 Fill out a cover letter 
and a resume when 
looking for a new job.



SELECTING TEXT 

With Word Processing, before you can cut (delete), move, copy, 
italicize, underline, or otherwise change copy, you need to select 
text. 

You can tell it is selected when it is darkened, either in a light blue 
or gray color, like this. 

 
Double-click to select a word        

To highlight a sentence, drag with the 
mouse – right to left or left to right, 
across the sentence. 

Triple-click to select a paragraph 

Select everything, using Control (Ctrl) A  or “Select all” in the 
Editing group, to select the entire document 9/5/2023 5
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SHORTCUTES FOR WORKING WITH TEXT
These keyboard shortcuts are useful when working with text in 
word processors, email applications, and more. They can help you 
perform commonly repeated tasks, like copying and 
pasting text.

Ctrl+X: Cut the selected text.

Ctrl+C: Copy the selected text.

Ctrl+V: Paste the copied or cut text.

Ctrl+A: Select all of the text on the                                      
page or in the active window.

Ctrl+B: Bold the selected text.

Ctrl+I: Italicize the selected text.

Ctrl+U: Underline the selected text.
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THE CLIPBOARD

If you are trying to copy, cut, and then paste something that you copied 
from a webpage, then the options on the “Clipboard” section, on the left 
side of the ribbon, will be of great help.  

The Clipboard is a memory location that holds what you either copied or cut 
from a document.

It can only hold one item in its memory, at a time.

Notice that the “Cut” and “Copy” icons are light, until text is highlighted.
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COPYING TEXT WITHIN A DOCUMENT
• Select (highlight) text.  Click on the 
Copy icon or press Ctrl+C.  This 
copies the selected text into the 
Clipboard memory. 

 
• Click within the document where 
you wish to insert the copied text.

• Click on the Paste icon or Press 
Ctrl+V.  

• This pastes the text from the 
Clipboard to the current position of 
the 'Insertion point'. 

TIP: The 'Insertion Point' is 
indicated by the flashing, vertical 
cursor.
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MOVING (CUTTING) TEXT WITHIN A DOCUMENT

• Select (highlight) the text you wish to 
move.  Click on the Cut (picture of 
the scissors) or Press Ctrl+X.  This 
cuts (removes) the selected text and 
puts it into the Clipboard memory.  

• Click within the document at the 
location you want to move the text to.  

• Click on Paste or press Ctrl+V. 

  This pastes the text from the 
Clipboard to the current position of 
the Insertion point. 

Cut

119/5/2023

http://www.google.com/url?sa=i&rct=j&q=&esrc=s&source=images&cd=&cad=rja&uact=8&ved=0ahUKEwj6z7u1wZPUAhWDRyYKHTkSB5EQjRwIBw&url=http://www.thinkstockphotos.com/royalty-free/scissors-pictures&psig=AFQjCNFCuxCxTr8Kq321_3EsEV87H89wcg&ust=1496092542081197


9/5/2023 12

TABS FOR PASTING DIFFERENT ITEMS

There are 3 ways to paste, and you can choose the one that best fits your 
needs.

1. Use the key combination Ctrl + "V“

2. Right click an empty space on the document and select "Paste.“

3. Under the "Home" tab, select the "Paste" button to see the different 
paste options.
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PASTE OPTIONS

When you paste text into the document, "Paste Options" will appear 
and allow you to select different options, depending on the type of content 
you're pasting.
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FOR A GOOD EXAMPLE OF TEXT THAT 
ILLUSTRATES THE USE OF THE KEYS 
ON A KEYBOARD, WE WILL USE THE 
LYRICS TO THE SONG “MERCEDES-
BENZ, BY JANIS JOPLIN

To find a good source for the lyrics to the 
song Mercedes-Benz, click on the CHROME 
icon  

in the Taskbar, to open Google.

In the rectangular search windows in the 
middle of the page, type in “Lyrics to 
Mercedes-Benz” (without the quotation 
marks).   Then click on the Enter key, 
which means “Go”

After you see the words, move your mouse 
across them to highlight all of the 
words, right click and then click copy.  

Then go to a WordPad blank page and click 
Paste. 
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UNDO AND REDO
• The Undo icon (the blue, curved, left-pointing arrow )  in the Quick 

Access Toolbar at the top left of the screen, it allows you to undo a 
mistake.   On a humorous basis, make it your best computer 
friend !

• It will undo up to 100 of your past keystrokes on the keyboard !!  You can 
also use the shortcut Ctrl  z  to do it.

• To change back, you can use the Redo icon (the blue, curved arrow that 
points to the right, or the shortcut Ctrl  y.

• The extra nice thing about using the shortcut Ctrl z for Undo is 
that it will undo each of your last choices, even if the Undo Icon 
isn’t showing !!
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THE 5 GROUP OF OPTIONS ON THE HOME TAB OF THE WORDPAD 
RIBBON

 

It is divided into 3 parts – Tabs, Groups, and Commands
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WordPad’s ribbon-based options under the HOME tab are divided into 5 
major groups:“Clipboard”, “Font”, “Paragraph”, “Insert” and “Editing” 
and most of them are geared towards making changes  on the stuff that you 
put into the document that you are creating.



USING THE INSERTION POINT TO ADD TEXT - The insertion point is 
the blinking vertical line in your document. It indicates where you can 
enter text on the page. You can use the insertion point in a variety of 
ways. 

Blank document: When a new blank document opens, the insertion point 
will appear in the top-left corner of the page.  If you want, you can begin 
typing from this location. 

As you type, “Wordwrap” lets the text go automatically to the next line. 
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The word Default can be confusing.   It is the option that is chosen 
automatically for the person to use or start using first.

THE 298 ! TYPES OF FONTS ARE LISTED ON THE VERTICAL LIST, WHEN 
YOU CLICK ON THE SMALL DOWNWARD POINTING TRIANGLE.  THE 
DEFAULT TYPE OF FONT IS CALIBRI.   

199/5/2023

A NEAT HINT   

IF YOU LIKE A  FONT THAT 
STARTS WITH A CERTAIN 
LETTER, YOU CAN TOUCH 
THE LETTER ON YOUR 
KEYBOARD AND IT WILL GO 
RIGHT TO IT. 

I LIKE THE FONT VERDANA 
SO ALL I HAVE TO DO IT HIT 
THE V KEY, IF IT ISN’T 
SHOWING.



FONT SIZE
The font size refers to the height of the text, based on 
72 points (pt), to the inch.  The default size is 11pt.

The different sizes are shown when you click on the 
down arrow, to the right of the Font type.  12 pt is 
good for regular text and should be larger, like this 
17 pt text for presentations.

Below is 7 pt font size text, which is almost  
unreadable when seen at a distance, so try and use    
a font size that is easy to read on a screen and that   
is also easy to read when printed.   

                                          This print is 7 points high

                                     

                              This print is 10 points high

h

                         This print is 12 points high.

A cool tip:   if you need to select a font size that is   
in between any of the default numbers given, you   
can type in the number where the blue window is at 
the top, and it will make it that size !! 209/5/2023



Arrow keys: 

You can also use the arrow keys on your keyboard to move the insertion 
point without deleting any text. 

The left and right arrow keys will move between adjacent characters 
on the same line, while the up and down arrows will move between 
lines. 

You can also press Ctrl+Left or Ctrl+Right to quickly move between 
entire words. 

In a new blank document, you can double-click the mouse to move the 
insertion point on the page. 9/5/2023 21



WHAT ARE KEYBOARD SHORTCUTS?

Keyboard shortcuts are keys or a combination of keys you 
can press on your keyboard to perform a variety of tasks. 

Using keyboard shortcuts is often faster than using a 
mouse because you can keep both hands on the keyboard.

Keyboard shortcuts are also universal, which means you can 
use many of the same shortcuts in a variety of 
applications. 

For example, you can use the shortcuts to copy and paste 
text in a word processor or in a web browser.
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USING SHORTCUTS - Many keyboard shortcuts require 
you to press two or more keys in a specific order. 

For example, to perform the shortcut Ctrl+X to CUT or 
remove a word, you would press and hold 
the Ctrl key, then press the X key, then release.

You'll use the Ctrl (Control) key to perform most 
keyboard shortcuts. You'll find this key at the bottom-
left corner of your keyboard.
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WORKING WITH TEXT
These keyboard shortcuts are useful when working with text in 
word processors, email applications, and more. They can help you 
perform commonly repeated tasks, like copying and 
pasting text.

Ctrl+X: Cut the selected text.

Ctrl+C: Copy the selected text.

Ctrl+V: Paste the copied or cut text.

Ctrl+A: Select all of the text on the                                      
page or in the active window.

Ctrl+B: Bold the selected text.

Ctrl+I: Italicize the selected text.

Ctrl+U: Underline the selected text.

9/5/2023 24



THE FONT GROUP

Next, if there are words or phrases that need to be Underlined, 
set to Bold or Italicized, then you can use some options under 
the “Fonts” section. 

From here, you will also find a place to make changes to the Font 
style and as well as Font size or even change the Font color, 
using some, easy-to-use options and controls.
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FONT GROUP 

Underneath the window 
for the Font type, are 3 
other formatting items: 

 B will Bold text. (A 
shortcut is CTRL + B)

 I will Italicize text. (A 
shortcut is CTRL + I)

 U will underline text. (A 
shortcut is CTRL + U)
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abc (strikethrough).  

For recommending editing, it 
places lines through text to 
indicate it is to be deleted.

MARKER (text highlighter). 
Will highlight text as if you had 
used a highlighter. The down 
arrow will  give you the choice 
of 15 different colors.

27

FONT COLOR:  The A will change 
the color of your words or letters. 
Select colors by clicking on the 
down arrow, that is to the right of 
the A.  
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You can also highlight the background of your text with the marker in 
this section and using the arrow to the right of it, to decide on what 
color to use:

O! say can you see by the dawn's early light,
What so proudly we hailed at the twilight's last gleaming,

Whose broad stripes and bright stars through the perilous fight,
O'er the ramparts we watch'd, were so gallantly streaming?

And the Rockets' red glare, the Bombs bursting in air,
Gave proof through the night that our Flag was still there;

O! say does that star-spangled Banner yet wave,
O'er the Land of the free and the home of the brave?



This is a sample 
paragraph that is 
used to illustrate 
left-justified (or 
aligned) text.   
The shortcut for 
this is Ctrl L

This is a sample 
paragraph that  

is used to 
illustrate 

centered text 
that is centered 
between the left 

and right 
margins.  The 

shortcut for this 
is Ctrl E

This is a sample 
paragraph that 

is used to 
illustrate right-
justified text, 

that  is aligned 
on the right.  

The shortcut for 
this is Ctrl R 

This is a sample paragraph 
that is used to illustrate full 
text alignment.

(Note that a paragraph like 
the one above and this 
one, isn’t very wide, so 
they can have spaces 
between words that are too 
big and don’t look good, 
compared to a full page of 
text.)  Shortcut is Ctrl J
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[Date]
Ms. Rhonda West
Customer Service Manager
Acme Inc.
123 Corporate Blvd.
Sometown, CO 50802

Re: Customer Service Representative Opening (Ref. ID: CS300-Denver)

Dear Ms. West:

I was excited to see your opening for a customer service rep, and I hope to be invited for an 
interview.

My background includes serving as a customer service associate within both call-center and retail 
environments. Most recently, I worked on the customer service desk for Discount-Mart,           
where my responsibilities included handling customer merchandise returns, issuing refunds/store 
credits, flagging damaged merchandise for shipment back to vendors and providing back-up 
cashiering during busy periods.

I also bring to the table strong computer proficiencies in MS Word, MS Excel and CRM database 
applications and a year of college (business major). Please see the accompanying resume           
for details of my experience and education.

I am confident that I can offer you the customer service, communication and problem-solving skills 
you are seeking. Feel free to call me at 555-555-5555 (home) or 555-555-5500 (cell) to arrange 
an interview. Thank you for your time—I look forward to learning more about this opportunity!

Sincerely,

Sue Ling
Enclosure: Resume
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The Insert and Editing Options - Finally, the last two groups of options 
are more focused on objects and image that you add to the document that 
you are working on. 

For instance, you can add a “Picture” stored in your computer’s hard drive 
or decide to add some artistic effects on the document by clicking on the 
“Paint drawing” options. (The Paint program can also be found in Windows 
Accessories)

Date and time as well as other objects and shapes can also be inserted to 
your document so take time to explore on these options when you are not 
busy.

Lastly, the “Editing” group of options are more focused in just finding 
texts and replacing them so you don’t need to be concerned about it that 
much. 
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THE FILE MENU OF WORDPAD

To open the File menu, click on the 
top, left, Blue WordPad FILE menu 

This menu is used for functions 
like creating a new document, 
opening an already saved 
document, saving a document, 
printing, and page set up.

Note: When you create a new 
document, the first thing you should 
do is to click on the  Save As words. 

You will then need to give it a name 
and tell the computer where you 
want to save it.

Save As... has a drop-down list of 
options for saving.   

The best one for the type of text 
used in WordPad documents is 
“Rich Text Document”

389/5/2023



9/5/2023 39



OPENING AN EXISTING WORDPAD DOCUMENT

There are several ways to open documents you recently 
worked on:
◦ 1)  Click on the top, left, Blue WordPad  FILE menu and look at the 

right side panel to see the most recently opened files and double 
click on the one you want.

◦ 2)  If the document you want isn‘t shown, click on the Open icon 
and it will let you find the document you want, in your computer 
listings. 409/5/2023



Saving a WordPad Document
Once you have done a “Save As” for your document, the easiest 
method that is recommended to regularly Save your document, is 
to point your mouse at the small square image of a Floppy Disc 
at the top, left of the screen and click on it.

As you keep typing, you should keep on saving the 
changes you are making, every 5 minutes or less. 

If you are finished with a document, and have saved it, and want 
to start on a new one, click on the blue “WordPad” icon a the top 
left, and then click on “New”.  
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Closing a WordPad Document
To close a document, there are 2 choices:

◦ The easiest way is to click the top, X in the red “close” window, 
◦ to quit the document and WordPad

If you want to close the document and get out of the WordPad program, you 
can click on the Blue “WordPad” icon at the top left and the last item in its 
list is “Exit”, which you can click on.   

For either option, if you haven’t saved everything in your document, it will 
ask you if you want to save it.
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Printing a WordPad Document
WordPad lets you print documents by using Print... an option in the 
list after you click on the blue, “WordPad” rectangle a the top left.  

    You can also use the shortcut – Ctrl  p

◦ Before you print, should always select Print Preview.  To 
    find it, go to the next page.

Print preview lets you see the way your document will look like     
when printed and you can then make any changes before you print 
it.

◦ It gives you a miniature version of document, an outline of text 
area framed against full page, as shown on the next page

◦ The mouse pointer becomes a magnifying glass that you can click 
on any area, to see a closer view.

◦ Icons at the top offer the opportunity to print, advance to the Next 
Page, return to Previous Page, get Two-Page view, Zoom In/Out, 
and Close9/5/2023 43



(To go to Print preview, point 
to (don’t click on it) the word 
“Print” in the File menu and 
then point your mouse at the 
“Print preview” words, and  
click on it.)
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This is the view on the Ribbon, when you click on the VIEW Tab  You can 
click on the button to Zoom in or out, use or not use the ruler and status 
bar, and make sure the Word wrap is on as well as choose inches or 
centimeters for the measurement for the ruler.
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DELETE:

If you press the delete key to delete a document or a folder, it will 
be put into the “Recycle Bin” and you can get it back whenever 
you want, by going into the Recycle Bin, look for your file and 
then click on “Restore”.

SHIFT-DELETE:

If you are sure that you want to permanently delete it, hold the 
Shift key down while you press the delete button and then it will 
be removed.

The next picture is not a good way to delete text9/5/2023 51
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Inserting Objects in a WordPad Document

You can insert a wide range of objects into a WordPad 
document

◦ Object images, pictures, media clips, worksheets, 
charts, etc.

◦ You can combine text with illustrations, giving you 
freedom for creativity and innovation.

Right Click on the item and click on Copy.   Go to the 
page in your document and put your cursor where you 
want it, and then click Paste
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COPYING IMAGES TO PUT IN YOUR DOCUMENT

You can copy photos from your computer, or you can go to an image website, 
such as Google Images, to pick and copy one, to put in your document.



EDITING OBJECTS, PICTURES, OR PHOTOS
Once an object is inserted into a document:
◦ It can be re-sized
◦ It can be moved

◦ FIRST, CLICK ON THE PICTURE !!      
THEN YOU WILL SEE THE SMALL  
CIRCLES OR SQUARES.

  Sizing objects:
◦  8 small circles (handles) appear at the 4 
corners and at 4 midpoints.

◦  Use a corner handle to make the picture 
larger or smaller and keep the same 
proportions.

◦  Use a  middle handle to stretch it                 
up or down or sideways

◦  Go to the inside until you find a cross which 
you can use to move it by holding your left 

 b tt  d  d i  th  
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Use the circular arrow on a 
stem, to rotate the image. 
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